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IBM Aspera Connect User Guide for Windows

Welcome to the Connect documentation, where you can find information about how to install, maintain,
and use Connect.

Published Date: August 19, 2020

Introduction
IBM Aspera Connect is an install-on-demand application that facilitates high-speed uploads and
downloads with an Aspera transfer server. 

Connect is compatible with most standard Web browsers. It integrates all of Aspera's high-performance
transport technology in a small, easy-to-use package that provides unequaled control over transfer
parameters. Connect includes the following features:

Feature Description

FASP file transport High-performance transport technology.

Browser interface Uploads and downloads are launched transparently by a Web browser.

Flexible transfer types Easily transfer single files, multiple files, or entire directories.

Transfer retry and
resume

Automatically retries and resumes partial and failed transfers.

Browser-independent
transfer

The Web browser can be closed once transfer operations have begun.

Transfer monitor A built-in transfer monitor for visual rate control and monitoring.

HTTP fallback HTTP fallback mode for highly restrictive network environments.

Proxy support HTTP fallback and FASP proxy settings.

Content protection Password-protect files that are being transferred and stored on the remote
server.

Queuing Allow a fixed number of concurrent transfers, and place the rest in a queue.

Drag-and-Drop Support

When used with IBM Aspera Faspex and some third-party web applications, Connect supports the drag-
and-drop feature for specifying which files and folders to transfer; however, this feature is not available
for certain browsers. The following table shows which browsers support the drag-and-drop feature in this
release of Connect:

Browser Drag-and-Drop of Files Drag-and-Drop of Folders

Firefox Supported Supported

Chrome Supported Supported

Internet Explorer* Supported Not supported

Edge Not supported Not supported

Edge Chromium Supported Supported

* Drag-and-drop capability is limited with Internet Explorer because of how it records drop events.

IBM Aspera Connect User Guide for Windows  1



Setting Up Connect

Installation
The procedure for installing IBM Aspera Connect requires enabling a browser extension for Connect in
addition to installing the Connect application itself.

There are two ways to install Connect on your system:

• Guided Installation: The most common way of installing Connect. If Connect is not installed or needs
upgrading when you try to upload or download files from an Aspera web app, such as Aspera Faspex or
Aspera Shares, you are prompted to install Connect and guided through the process.

• Manual Installation: For system-wide (multi-user) installations, and a fallback method for users with
non-typical web apps. You first install the Connect web extension for your browser (with the exception
of Internet Explorer). You then install the Connect application by running a desktop installer you
download from the Aspera website.

System Requirements: For information on supported operating systems and browsers, see the release
notes for this version of IBM Aspera Connect.

Important:

• You cannot install Connect under the Guest account.
• Before performing a system-wide installation (all users of the machine), uninstall any per-user

installations. Aspera does not support local and system-wide installations of Connect on the same
system. For uninstallation instructions, see “Uninstalling” on page 26.

• Connect works better when your browser's local storage is enabled; however, it is not a requirement.

Guided Installation
If you do not have Connect installed and you attempt to transfer packages or files using an Aspera web
application (such as Faspex or Shares), the Connect Welcome screen appears and prompts you to install
Connect:

Depending on your browser/platform combination, the screens shown in these instructions may vary.

1. To begin, click Install Extension.
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Your browser's page for the Connect extension opens. See the instructions for your browser in “Adding
the Connect Browser Extension” on page 4 to install the Connect extension. If successful, you'll see
the message confirming the extension has been added.

2. The welcome screen now prompts you to install the Connect application:

To install the Connect application, locate the installer app you just downloaded, open it, and click
Start.

Once the Connect application has been installed, refresh your browser.

Manual Installation
Step 1. Install the Connect extension for your browser.

For instructions about obtaining the Connect extension for your browser, see “Adding the Connect
Browser Extension” on page 4.

Step 2. Download and run the Connect application installer.
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You can download the Connect installer directly from https://www.ibm.com/aspera/connect/. Once
downloaded, run the installer and follow the Setup screens. You will need to accept the terms and
conditions, and confirm whether to install Connect for you only (Typical) or for all users of this machine
(Custom).

Adding the Connect Browser Extension
For supported web browsers, this section explains how to obtain and add the IBM Aspera Connect
extension to the browser you will use. The Connect extensions are specific to the browser; the procedure
for adding an extension to a browser is the same regardless of which OS platform that browser is running
on. With a guided install, clicking Install Extension opens the extension link for the browser you are
using. With a manual install, be sure to download the extension for the browser you intend to use with
Connect.

Chrome

To obtain and install the Connect extension for Chrome, follow the procedure below:

1. Click Install Extension (guided install method), or open the IBM Aspera Connect page on the Chrome
Web Store (manual install method). The following page opens:

2. Click Add to Chrome. The Add "IBM Aspera Connect"? popup appears.
3. Click Add extension.

If successful, you'll see the message "IBM Aspera Connect has been added to Chrome".

Note: The extension is activated only by websites that have integrated IBM Aspera for file transfers. The
extension never reads or stores any personal information or history.

Incognito Mode: By default, the Connect extension is disabled in Chrome's incognito mode. To enable the
Connect extension, right-click the small Connect icon in the upper-right corner of your browser page.
Then open Manage extensions and scroll down to the heading Allow in incognito. Then set the switch to
ON as shown below.
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Firefox

To obtain and install the Connect extension for Firefox follow the procedure below:

1. Click Add extension (guided install method), or open the IBM Aspera Connect page on the Firefox
Add-Ons page (manual install method). The following page opens:

2. Click + Add to Firefox. The Add IBM Aspera Connect? popup appears.

3. Click Add.

If successful, you'll see the message "IBM Aspera Connect has been added to Firefox".

Internet Explorer

Instead of a browser extension, Microsoft Internet Explorer uses an ActiveX add-on. Enabling the add-on:
When you open HSTS or Faspex using Internet Explorer 11, an information bar appears and asks whether
to run the Connect add-on. Click Allow to proceed:

Microsoft Edge

To obtain and install the Connect extension for Microsoft Edge, follow the procedure below:

1. Click Install Extension (guided install method). Or, open the IBM Aspera Connect for Edge page on the
Microsoft Store (manual install method). The following page opens:
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(If you are prompted to sign in, doing so is not required. You can dismiss the Sign in window.)
2. Click Install.

If the message below appears, clicking Refresh the page usually resolves it.

A popup appears indicating the extension is installed.

3. Click Launch. This returns you to the browser, and the following popup appears:
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If clicking Launch opens an empty window, return to the browser and the above popup should appear.
4. Click Turn it on.

Note: If the Connect extension for Edge is disabled, and you try to use a web app, the launch bar asks you
to install the extension. Clicking Install Extension opens the Microsoft app store and shows a Launch
button—however, the Launch button will not enable the extension. Enable the extension in the settings for
Edge.

Microsoft Edge Chromium

To obtain and install the Connect extension for Edge Chromium, follow these steps:

1. Click Install Extension (guided install method), or open the IBM Aspera Connect page on the Chrome
Web Store (manual install method). Typically, the extension page that opens looks like the following
screen, with no visible download button. To enable downloading, click the link Allow extensions from
other stores. The Add to Chrome is now visible.

2. Click Add to Chrome. The Add "IBM Aspera Connect"? popup appears.
3. Click Add extension.

If successful, you'll see the message "IBM Aspera Connect has been added to Edge Chromium".

After Installation
Once Connect is installed, you can launch it from the following location:

Start > All Programs > Aspera > Aspera Connect

On Windows 10, > > Aspera > Aspera Connect.

Tip: Aspera provides a web-based diagnostic tool that can be helpful in identifying connection issues.
You can access the IBM Aspera Connect Diagnostic Tool here:

https://test-connect.asperasoft.com/
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Network Environment
Connect typically requires some configuration steps in order to function in your network environment.
Configuration settings also allow you to limit transfer rates and use an HTTP proxy.

If you need to configure any network proxies or override network speeds, you can do so through
Connect's Network option. Before modifying Connect's network configuration, review the network
requirements below, which describe ports that may need to be open on your network (such as ports 22
and 33001).

Network Requirements
Your SSH outbound connection may differ based on your organization's network practices. Although TCP/
33001 is the default setting, consult your IT department for questions related to which SSH ports are
open for file transfer. Also see the help documentation for your particular operating system, for specific
instructions on configuring your firewall. If your client host is behind a firewall that does not allow
outbound connections, you will need to allow the following:

• Outbound connections for SSH, which is TCP/33001 by default, although the server side may run SSH
on another port. Check with your IT department for which SSH ports are open for file transfers.

• Outbound connections for FASP transfers, which is UDP/33001 by default, although the server side may
run FASP transfers on one or more other ports. Check with your IT department for which SSH ports are
open for FASP transfers.

Limit Transfer Rates
Important: Set values in these fields only if you need to limit the bandwidth that Connect uses. For
example, your office may have limited bandwidth to share among its users. Exception: For the SaaS
products Files and Aspera on Cloud, use this field to set the default transfer speed.

Launch Connect as follows:

Start > All Programs > Aspera > Aspera Connect

On Windows 10, > > Aspera > Aspera Connect.

Open Preferences:

From the system tray: Right-click  > Preferences

You can limit Connect transfer rates from the Bandwidth tab:
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You can limit the download and upload transfer rates by enabling the respective checkboxes and entering
a rate in either Mbps or Kbps. Note that setting a maximum speed doesn't guarantee your transfers will
ever achieve that speed. Actual performance depends on the following factors:

• Your network's bandwidth: Available bandwidth on your network may limit your transfer rate, even if you
enter larger numbers into these fields.

• Your Aspera server transfer settings: Settings on your server may limit your transfer rate even if your
network bandwidth and the numbers you enter are larger.

HTTP Proxy
HTTP fallback serves as a secondary transfer method when the Internet connectivity required for Aspera
accelerated transfers (UDP port 33001, by default) is unavailable. If UDP connectivity is lost or cannot be
established, if you have configured an HTTP proxy, the transfer continues over the HTTP protocol based
on this proxy configuration.

Note: Although the HTTP proxy is used primarily for the HTTP fallback feature, it can be used for all HTTP-
related activities performed by Connect. However, it cannot be used for FASP transfers.

To configure and enable an HTTP proxy server, open Preferences > Network in Connect and look for the
HTTP Proxy section.
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To configure the HTTP proxy, select one of the following configuration methods from the drop-down list:

• System – to have Connect use the HTTP proxy settings that are configured for your operating system.
• Manual – to enter your HTTP proxy settings manually. (This may require the assistance of your system

administrator.)

These settings include username and password authentication credentials, as well as the host name, IP
address, and port number.

Note that the Use HTTP Proxy checkbox and fields are enabled only if you select Manual.

IBM Aspera Proxy
When IBM Aspera Proxy (a.k.a. FASP proxy) is enabled, Aspera passes the DNAT or DNATS (secure)
username, password, server address, and port to ascp.

To set up a FASP proxy, do the following:

1. Go to Preferences > Network in Connect and locate the FASP Proxy section in the lower half of the
dialog.

2. Select the following checkboxes:

• Use FASP Proxy (DNAT)
• Secure (DNATS)

3. Enter your proxy server username, password, address, and port number.

Basic Configuration
The Connect Preferences dialog allows you to configure logging behavior and various options for file
transfers, such as transfer queuing, file download location, and the allowed number transfer retries.

To change the application's default settings, launch Connect as follows:

Start > All Programs > Aspera > Aspera Connect

On Windows 10, > > Aspera > Aspera Connect.

Open Preferences:

From the system tray: Right-click  > Preferences
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General Preferences
Connect's general application behavior can be configured in the General tab.

Under the General tab, you can modify the following settings:

• Specify whether to launch Connect whenever the user logs in to the system.
• Specify how to remove transfer sessions from the Activity window: manually, or automatically on

successful transfers.
• Specify the level of detail to be logged for transfers:

– Info – Default. Displays general messages about requests, ascp spawn options, and transfer status
changes. 

– Debug – Verbose. Displays validation and FASP management messages, and passes -D to ascp.
– Trace – Extra verbose. Passes -DD to ascp. Used only for diagnosing problems.
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The logging feature is typically used for troubleshooting and when contacting IBM Aspera Support.

Transfer Preferences
Connect's transfer behavior can be configured under Preferences > Transfers.
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Downloads

By default, Connect downloads files to the current user's Downloads folder. To change this setting, adjust
the following settings:

• Save downloaded files to – Specify the path to the location where downloaded files should be saved.
• Always ask me where to save downloaded files – Choose this option to select a location for each

download.

Queue

• Enable queuing – Enable or disable the queuing of transfers.
• Maximum concurrent transfers – This allows a specified number of transfers to run concurrently and

places the remainder in a queue.

Retry

You can set a retry rule if a transfer fails. Set the retry rule as follows:

• Automatically retry failed transfers – enable or disable.
• Attempts – specify the number of times Connect should retry a failed transfer.
• Interval – specify the amount of time for Connect to wait before retrying a transfer (in seconds,

minutes, or hours).

Multi-Session

For information on configuring multi-session transfers, see “Multi-Session Transfers” on page 18.
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Security Configuration
Connect security facilities allow you to specify restricted and trusted hosts, encrypt content, and manage
authentication credentials.

Connect features the following capabilities for minimizing security risks when uploading or downloading
files:

• You can add Aspera servers as Trusted Hosts to avoid the recurring security prompt, or add servers to
the Restricted Hosts list to require confirmation every time you attempt to initiate a transfer with that
host.

• You have the option of saving your authentication credentials when you connect to a server, as well as
removing them from the Passwords tab.

• Content protection is a feature that allows uploaded files to be encrypted during a transfer for the
purpose of protecting them while stored on a remote server. The uploader sets a password while
uploading the file, and the password is required to decrypt the protected file.

The settings above can be configured in the Connect Preferences dialog. To open it, first launch Connect:

Start > All Programs > Aspera > Aspera Connect

On Windows 10,  >  > Aspera > Aspera Connect.

Then, from the system tray, right-click  > Preferences

Managing Hosts
When a transfer is initiated and the Remember my choice for this site option is enabled in the
confirmation dialog, the server you are allowing or denying is added to the Trusted Hosts or Restricted
Hosts list, respectively. To view, add or remove additional trusted hosts, go to Security > Trusted Hosts.
Enter the host's address in the specified text field and click Add.
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To view, add or remove restricted hosts, go to Security > Restricted Hosts. Here, enter the host's address
in the specified text field and click Add.

Whenever you initiate a transfer to or from a host in the Restricted Hosts list or a host that's not in the
Trusted Hosts list, Connect displays a security warning asking whether you want to grant access to the
host for this transfer:

Managing Passwords
To view or remove saved password information for a host, go to Security > Passwords. Here, you can
remove saved login credentials; however, you cannot add credentials to this list directly.
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Whenever you attempt a transfer with a server where your credentials are not saved, you are prompted
with an authentication dialog and offered a Remember this password checkbox. Marking the checkbox
causes your login credentials to be saved and appear in the Passwords tab.

Content Protection
To specify hosts to which you want all uploads to be encrypted, open the Content Protection tab under
Security. In the Address field enter the Aspera server address and click Add. The server is then added to
the list.

When uploading files to a server on the list, or one that is configured as a content-protected host, you are
prompted for a passphrase to encrypt the files. You can also choose not to encrypt files if the server
allows it.

For details on encryption and decryption, see File Encryption.
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Transferring Files with Connect

Initiating a Transfer
You can use Connect with the Aspera demo server to test basic transfer functionality and also familiarize
yourself with how to initiate uploads and downloads.

About this task
The steps below describe how to initiate a file transfer, and shows how to perform a download from
Aspera's demo server.

Important: In order for Connect to function correctly, your browser must have cookies enabled. For
instructions on verifying this setting, see the help documentation for your browser.e

Procedure
1. Open your web browser and log in to Aspera's demo transfer server at https://aspera.pub/60OtzmU.

Note: Internet Explorer 11 Security Settings: When you open HSTS or Faspex using Internet Explorer
11, an information bar appears and asks whether to run the Connect add-on. Click Allow to proceed.

2. In AoC Demo page, open the folder small.

To select a file or folder you want to download, click the checkbox next to it. You can also click multiple
boxes to select more than one file or folder to download at a time. Once you've made your selections,
click the Download button.

3. Confirm the download.

A dialog appears asking whether you want to allow the server access to your machine. Select Yes to
begin. To skip this dialog in the future, enable the checkbox Remember my choice for this site. The
server is then added to your Trusted Hosts list. For more information on trusted hosts and how to
manage them, see “Security Configuration” on page 14.
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NOTE: The way hosts are granted access differs from previous Connect releases. Instead of prompting
for permission to communicate with a transfer node when a transfer is about to start, Connect prompts
for the website when the website first tries to interact with the Connect APIs. Thus, the address in the
dialog is no longer a transfer server, but is instead the address of the website. As a result, sites that
perform transfers with many different hosts no longer need to respond to access requests from each of
those hosts, because there will be only a single request for the web site.

Results

Once you confirm that the configuration settings are correct and that Connect is working properly, you can
begin transferring with your organization's Aspera server. To get started, simply point your browser to your
server's host name. For example, if the server is running IBM Aspera High-Speed Transfer Server:

 http://server_host_name/aspera/user

Note that the URL format of the address can be different, depending on your server product.

Multi-Session Transfers
Data can be transferred faster by using multiple-session transfers (also known as parallel transfers and
multi-part transfers) to and from multi-node servers and clusters, on premises, or in the cloud.

If a transfer meets the criteria that you configure in the Connect Preferences dialog, files are
automatically transferred with multiple sessions.
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Configuring Multi-Session Transfers

• Enable multi-session – Enable or disable multi-session transfers.
• Number of sessions – The number of sessions you prefer (as guidance, not as a requirement).
• When transferring faster than – The transfer speed that triggers multi-session transfers.
• Split files larger than – When the box is checked, enable file splitting for files larger than or equal to the
specified size. This value is sometimes also referred to as the multi-session threshold. For example,
using the default size value (60 MB), if the source directory contains multiple files, all files less than 60
MB are distributed between sessions, while all files 60 MB or larger are split and then distributed
between sessions. If the source directory contains only one file and the file is 60 MB or larger, the file is
split, otherwise the file is transferred by one session.

• Startup interval between sessions – The amount of time to wait before the next session starts.

Limitations
• Encryption-at-Rest (EAR): Files cannot be split when EAR is used. If EAR is specified, splitting is

disabled.
• Resuming Transfers: When file splitting is enabled, the ascp resume-transfer option is set to -k 0

(always transfer the entire file again). Recommended: If you need the ability to resume transfers,
disable file splitting.

• HTTP Fallback: HTTP fallback cannot be used with multi-session transfers. If specified, HTTP fallback
is ignored.
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• Single-File Transfers Without Splitting: A multi-session transfer of a single file without file splitting
potentially results in a slower transfer. The target rate for each session is 1/N of the total target rate. If a
file is not split, only one session does productive work. This might not be an actual limitation if the
single session is already taking advantage of all available bandwidth; for example, if the same transfer
rate was obtained by a single session transferring at maximum speed.

Recommended Practices
• When to Use Multi-Session: Enable multi-session only when:

– You have a fast network connection (>1 Gbps).
– The server has a slower network connection than you (cloud virtual machines).
– Additional servers are available to handle additional traffic (cluster of servers).

• Startup Interval: If you have a large transfer that would require the transfer cluster to scale to meet the
demand, set a higher startup interval to allow additional virtual machines to come online. It can take
5-15 minutes for new instances to become available.

The Activity Window
In the Activity window, you can view and manage all transfer sessions. From here you can stop a transfer,
resume it, retry a failed transfer, and open the location containing the content.

The Activity window contains the following controls:

•  Open the Transfer Monitor. For more information on this feature, see Monitoring Transfers.

•  Open the folder on your computer that contains this content.

•  Stop the transfer.

•  Resume a stopped transfer, or retry a failed transfer.

When the queuing option is enabled, the number of concurrent transfers is limited. The additional
transfers are queued in the Activity window and initiated when a transfer is finished. You can manually
start a queued transfer by clicking the  button. You can also right-click on a started or stopped transfer
to access various controls. The example below shows the right-click options for a stopped transfer.
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Monitoring Transfers
From the Transfer Monitor window, Connect lets you monitor transfer progress. The Transfer Monitor
provides a graphical interface to adjust file transfer speed, adjust the minimum transfer rate, and set rate
policy—all while the transfer is in progress.

To monitor a transfer session shown in the Activity window, click the  icon shown with the session. The
Transfer Monitor opens:

The following controls are available in this window:

•  Open the folder on your computer that contains this content.

•  Stop the transfer.

•  Resume a stopped transfer, or retry a failed transfer.
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If you have sufficient server privileges and your transfer server is configured to allow it, you can adjust or
set your desired transfer rate, minimum transfer rate, and rate policy. However, actual performance is
subject to the available bandwidth on your network as well as the transfer settings on your server:

• Target transfer rate – To adjust the transfer rate, locate and select the upper slider  on the left side of
the graph and move it up or down to change the desired rate. Note that the actual rate depends on
several factors.

• Minimum transfer rate – To set the minimum transfer speed, locate and select the bottom slider  on
the left side of the graph and move it up or down to set the desired rate. The actual minimum rate
depends on several factors.

• Transfer policy – Select the transfer policy from the drop-down list at the bottom of the window. Note
that your specified rate policy may be subject to external limitations:
Fixed

The transfer transmits data at a rate equal to the target rate, although this may impact the
performance of other traffic present on the network.

High
The transfer rate is adjusted to use the available bandwidth up to the maximum rate.

Fair
The transfer attempts to transmit data at a rate equal to the target rate. If network conditions do not
permit that, it transfers at a rate lower than the target rate, but no less than the minimum rate.

Low
The transfer rate is less aggressive than Fair when sharing bandwidth with other network traffic.
When congestion occurs, the transfer rate is decreased to the minimum rate, until other traffic
retreats.

• Additional options – Right-clicking in the area above the graph opens the same menu as doing so in the
Activity window, giving options such as stop or remove transfers, and open the transfer's containing
folder.

File Encryption
Connect provides a means to protect files with Aspera encryption when the files are uploaded to a
content-protected server, and to decrypt those files when downloaded.

Whenever you upload files to a server configured as a content-protected host, Connect prompts you to
create a passphrase to protect the files with Aspera encryption. When you download those files, access to
the files' contents requires that you provide the passphrase to decrypt them. Files can be decrypted
during the download transfer, or decrypted after the download is complete. Files can be decrypted from
within Connect, or by using the utility IBM Aspera Crypt, which is included in the Connect installation.

Encrypting Files
Servers to which you want to upload encrypted files must be enabled for content protection. For more
information, see the Content Protection section of Security Config.

When uploading files to a content-protected server, you are prompted for a passphrase to encrypt the
files. You can either enter the passphrase in the text field, or check Keep files unencrypted to proceed
without using this feature (if allowed by the server). To start the transfer, click OK.
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Once Aspera-encrypted files have been uploaded to your server, they can be identified by an additional
file extension, .aspera-env (Aspera Security Envelope).

Decrypting Files During Download
When you use Connect to download a content-protected file, a dialog opens prompting you for a
decryption passphrase:

You have two options:

• Enter the passphrase. In this case, Connect decrypts the files during the download. When the files arrive
at their destination, they are no longer encrypted, and no further steps are necessary.

• Check the Keep files encrypted box. In this case, Connect transfers the files to the destination in the
encrypted state. You don't need to enter a passphrase (if you do, it is ignored). With this option, the files
retain the .aspera-env extension on your disk. You can decrypt the files any time after the download
has completed.

Note: If you choose to decrypt encrypted files during download, the transfer may fail if the password you
supply doesn't apply to all the encrypted files. In this case, retry downloading and check the box for Keep
files encrypted. You can then decrypt them after they are downloaded. See “Decrypting Files after
Download” on page 24 below.
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To proceed with the download, click OK. The Connect Activity window appears and shows the progress of
the transfer. When finished, the progress bar disappears, indicating the files are now at their destination.

Decrypting Files after Download
To decrypt downloaded files you have chosen to keep encrypted, run the IBM Aspera Crypt utility. You can
launch Crypt using any of the following methods:

• From the Connect Activity window: Once the transfer is complete, the Connect Activity window displays
the link Unlock encrypted files:

To launch Crypt, click Unlock encrypted files. This is the most convenient method for unlocking
protected files once they've been transferred. Depending on your preferences settings, you can also
decrypt your files from here later, as the transfer records remain in the Connect Activity window until
you remove them by clicking Clear List. However, the files remain only if under the Preferences >
General you chose to remove transfer list items Manually instead of automatically after transfer.

• By opening an Aspera-encrypted file: You can launch Crypt by opening an .aspera-env file from the
context menu or by double-clicking the file.

• From the Connect application menu: To open the application menu, right-click the Connect icon in the
Windows system tray. To launch Crypt, select Unlock encrypted files.

When you launch Crypt, the following window opens:

If you launched Crypt from the Connect Activity window or by opening an aspera-env file, Crypt
decrypts the files that were selected. From the Crypt window, you can also select Open Files or Open
Folder and browse for files or folders to decrypt. When your encrypted contents are loaded into Crypt, a
status message appears at the bottom of the application, displaying the number of items ready for
decryption.
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To unlock protected content, fill in the encryption passphrase and click Decrypt. The files are unlocked
and the results displayed in the window:

The decrypted files are placed in the same directory as the original encrypted files:

If you choose to decrypt a file and there is already an unencrypted file of the same name in that folder, the
newly decrypted version appears in the Crypt window and the folder listing with "(decrypted)" added to
the filename, as in the above example. However, note that if you decrypt the file yet again, the
"(decrypted)" file is overwritten without notice.

Maintaining Your Connect Installation

Upgrading Connect
When a new version becomes available, Connect prompts you to confirm whether to upgrade.

Note: Before upgrading, ensure that you have no previous Connect installations on your system – either
single-user or system-wide.

If Connect does not prompt you to upgrade (for example, because the system has no Internet access),
you can obtain an upgrade from the Aspera download site. To download the latest version of Connect, go
to https://www.ibm.com/aspera/connect/. Click Download Now and follow the on-screen instructions.
This downloads the latest installer.

You are also prompted to upgrade with the following pop-up if you attempt a download and Connect is not
found or otherwise unable to launch:
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If Connect is not installed, or is out of date, you can download it from here by clicking Download latest
version. If Connect is already installed, you can click Troubleshoot to open the IBM Aspera Connect
Diagnostic Tool. You can also access the tool here:

https://test-connect.asperasoft.com/

Uninstalling
The Connect installation provides scripts for uninstalling Connect.

Uninstalling the Connect Application
Important: You must quit Connect before uninstalling it.

To uninstall Connect, quit both the Connect application and any open Web browsers. Additionally, ensure
that no other users are logged into this machine. Then, go to the Windows Control Panel and—depending
on the version of your Windows operating system—choose Add/Remove Programs or Programs and
Features. Select IBM Aspera Connect and uninstall it.

Removing the Connect Browser Extension
For Chrome, Firefox, and Microsoft Edge, the browser extension is removed separately, as described
below. Connect on Internet Explorer does not use a browser extension.

Chrome

To remove the extension from Chrome, click the three-dot icon in the upper right corner of the Chrome
window.

Note: In certain circumstances, the default three-dot icon may not be visible while displaced by other
icons. For example, a circular yellow/orange icon with an arrow indicates Chrome needs to be updated.

In the drop-down menu that opens, choose More Tools > Extensions:
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The Extensions tab opens. Look for the panel with the Connect extension and click Remove:

The Connect extension is now removed from Chrome.

Firefox

To remove the Connect extension for Firefox, open the three-bar icon in the upper right corner of the
browser window, and click Add-ons:
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The Add-ons Manager tab opens. Look for the panel with the Connect extension and click Remove:

The Connect extension is now removed from Firefox.

Internet Explorer

The ActiveX add-on for Internet Explorer is removed automatically when you uninstall the Connect
application.

Microsoft Edge

To remove the Connect extension for Microsoft Edge, click the three-dot icon in the upper right corner of
the Edge window. In the drop-down menu that opens, click Extensions:
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The Extensions tab opens. Look for the panel with the Connect extension and click Remove:

The Connect extension is now removed from Microsoft Edge.

File Cleanup
You can safely remove old Connect files from your system.

Log Files
Log files are found in the following location. Log files can be removed at any time.

C:\Users\username\AppData\Local\Aspera\Aspera Connect\var\log\

http.uri and process.pid Files
You can remove the http.uri and process.pid files in the following folder:

C:\Users\username\AppData\Roaming\Aspera\Aspera Connect\var\run\

Database File
If you previously installed Connect for all users (that is, system-wide), then when uninstalling, you will
only be able to remove the Connect database for the current user. To remove the database file for all
users, you must locate and remove the database file for each user account:

C:\Users\username\AppData\Local\Aspera\Aspera Connect\var\asperaconnect.data 

Note that when uninstalling earlier versions of Connect, the database file may instead be found in the
following location:

C:\Users\username\.aspera\connect\connectdb.data 

Miscellaneous Files and Folders
C:\Users\username\AppData\Local\Aspera\connect-cleanup.log
C:\Users\username\AppData\Roaming\Aspera\
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Appendices

Log Files
You can access Connect log files from within Connect or from your file system.

Log Files
aspera-connect.log

log file for the Connect application
aspera-scp-transfer.log

log file for the ascp transfers
nativemessagehost.log

log file for host messages
ConnectInstall.log

log file for the quick installer

Log File Location
Log files are located in the following location:

C:\Users\username\AppData\Local\Aspera\Aspera Connect\var\log\

However, the log file for the quick installer is located here:

C:\Users\username\AppData\Local\Temp\AsperaLog\ConnectInstall.log

You can also access the log folder from the Connect system tray: right-click  > Open log folder

For information on removing old log files, see File Cleanup.

Deploying Connect Extensions in Closed Environments
Locked-down or enterprise environments without access to the public internet generally require special
steps to acquire and enable Connect web extensions. Depending on OS platform and browser, there are a
number of methods for doing so.

Chrome
Method: Manual deployment Using Drag and Drop

1. Download the Connect extension CRX file from Google. To do so, right-click this link and select Save
Link As: Connect extension for Chrome

2. Open chrome://extensions
3. Enable developer mode.
4. Drag-and-drop the CRX file into the chrome://extensions window to install.
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Method: Background Deployment Using the Windows registry

Requires network access to the Chrome update URLs:

https://clients2.google.com/service/update2/crx

1. Download the Connect extension CRX file from Google. To do so, right-click this link and select Save
Link As: Connect extension for Chrome

2. Create a .reg file containing the registry script below. Update the location of the CRX file. Make sure
the location is accessible to all users. Backslashes must be escaped as shown in the example.

3. Merge the registry keys above. Detailed instructions are here:

https://www.techwalla.com/articles/how-to-merge-registry-files

Windows Registry Editor Version 5.00

[HKEY_LOCAL_MACHINE\SOFTWARE\Google\Chrome\Extensions
\kpoecbkildamnnchnlgoboipnblgikpn]            
"update_url"="https://clients2.google.com/service/update2/crx"

[HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Google\Chrome\Extensions
\kpoecbkildamnnchnlgoboipnblgikpn]
"update_url"="https://clients2.google.com/service/update2/crx"

4. Restart Chrome. Users must approve the new extension on startup.

Firefox
Method: Manual deployment

1. Download the Connect extension XPI file from Mozilla. To do so, right-click this link and select Save
Link As: Connect extension for Mozilla

2. Open about:addons
3. From the menu, select Install Add-on From File.

Method: Background deployment via Windows registry

1. Obtain a copy of the Connect Firefox XPI file. See Method: Manual deployment above.
2. Create a .reg file containing the registry script below. Update the location of the XPI file. Make sure the

location is accessible by all users. Backslashes must be escaped as shown in the example:

Windows Registry Editor Version 5.00

[HKEY_LOCAL_MACHINE\SOFTWARE\Mozilla\Firefox\Extensions]
"connect@aspera.ibm.com"="C:\\Users\\aspera\\Desktop\\connect@aspera.ibm.com.xpi"

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Mozilla\Firefox\Extensions]
"connect@aspera.ibm.com"="C:\\Users\\aspera\\Desktop\\connect@aspera.ibm.com.xpi"

3. Merge the registry keys above. Detailed instructions can be found here:

https://www.techwalla.com/articles/how-to-merge-registry-files

4. Restart Firefox.
5. Open the Firefox add-ons:
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6. Enable the extension.

Background deployment using a roaming profile

1. Obtain a copy of the Connect Firefox XPI file. See Method: Manual deployment above.
2. Copy the xpi file to:

C:\Users\username\AppData\Roaming\Mozilla\Extensions\{ec8030f7-c20a-464f-9b0e-13a3a9e97384}\

3. Restart Firefox.
4. Open the Firefox add-ons:

5. Enable the extension.

Method: Background deployment via preference file

1. Obtain a copy of the Connect Firefox XPI file. See Method: Manual deployment above.
2. For user installs, modify the XPI_FILE variable to point to the XPI file. Run the following script:

#!/usr/bin/env bash
XPI_FILE=INSERT_XPI_PATH_HERE
EXT_ROOT="$HOME/Library/Application Support/Mozilla/Extensions/{ec8030f7-
c20a-464f-9b0e-13a3a9e97384}"
mkdir -p "$EXT_ROOT"
cp $XPI_FILE "$EXT_ROOT"
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3. For machine-installs, modify the XPI_FILE variable to point to the XPI file. Run this script using sudo:

#!/usr/bin/env bash
XPI_FILE=INSERT_XPI_PATH_HERE
EXT_ROOT="/Library/Application Support/Mozilla/Extensions/{ec8030f7-
c20a-464f-9b0e-13a3a9e97384}"
mkdir -p "$EXT_ROOT"
cp $XPI_FILE "$EXT_ROOT"

4. Restart Firefox.
5. Open the Firefox add-ons:

6. Enable the extension.

Method: Deploying Aspera Connect add-on with custom build of Firefox

See Mozilla documentation:

https://developer.mozilla.org/en-US/docs/Mozilla/Add-ons/WebExtensions/Distribution_options/Add-
ons_in_the_enterprise#Bundling_add-ons_with_a_custom_Firefox

Edge Chromium
Edge Chromium uses Connect's Chrome extension, which can be deployed using the Windows registry.

Method: Background deployment via Windows registry

The procedure below is based on instructions found on the official Microsoft website:

https://docs.microsoft.com/en-us/microsoft-edge/extensions-chromium/developer-guide/alternate-
distribution-options

1. Find or create this key in the registry:

32-bit Windows:

HKEY_LOCAL_MACHINE\Software\Microsoft\Edge\Extensions

64-bit Windows:

HKEY_LOCAL_MACHINE\Software\Wow6432Node\Microsoft\Edge\Extensions

2. Under the Extensions key, create a new key (folder) with the extension ID as the name:
kpoecbkildamnnchnlgoboipnblgikpn

• In your extension key, create a new string value, update_url, and set the value to the Chrome Web
Store update URL:
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https://clients2.google.com/service/update2/crx

• Launch the browser and go to edge://extensions. You should now see the extension listed.

Allowlisting the Chrome Extension
By default, all Chrome extensions are allowlisted (a.k.a. whitelisted). However, if your organization
blocklists all extensions by policy, you can override the blocklist and allow the Connect extension to be
installed by adding it to the allowlist.

https://www.chromium.org/administrators/policy-list-3#ExtensionInstallWhitelist

The instructional links below also include information on other extension-related policy settings that
enable you to automatically install Chrome, force-install Chrome, and so on.

Note: These policies are intended strictly for configuring instances of Google Chrome internal to your
organization. Use of these policies outside of your organization (for example, in a publicly distributed
program) is considered malware and will likely be labeled as malware by Google and anti-virus vendors.

Provisioning Policy Using Chrome Policy Templates: Group Policy Editor

1. Download and install Chrome policy template .adm or .admx files and add the templates to your Group
Policy editor. Detailed instructions can be found here:

https://support.google.com/chrome/a/answer/187202?hl=en

2. Open your Group Policy editor and navigate to the Chrome extensions settings:

Computer Configuration > Administrative Templates > Google > Google Chrome > Extensions

On Windows 7 or 10: Computer Configuration > Administrative Templates > Classic Administrative
Templates > Google > Google Chrome

3. Edit your Chrome extension policy settings. Detailed instructions can be found here:

https://support.google.com/chrome/a/answer/7532015?hl=en

Provisioning Policy Using the Windows Registry

Note: The recommended way to configure policy on Windows is via GPO, although provisioning policy via
registry is still supported for Windows instances that are joined to a Microsoft® Active Directory® domain.

Find the Windows registry location and set the value to the Connect extension ID:

Software\Policies\Google\Chrome\ExtensionInstallWhitelist\1 = "kpoecbkildamnnchnlgoboipnblgikpn"

Enabling FIPS
For FIPS capabilities, IBM Aspera provides a separate version of Connect. The installer is available on the
IBM Aspera download site.

In Connect for Windows, FIPS (Federal Information Processing Standards) is disabled by default. FIPS is
an encryption mode used by some US government entities. If you need to use the FIPS version of
Connect, run the FIPS-enabled installer available from the Connect download page:

Quick installer, recommended: IBMAsperaConnectSetup-ML-FIPS-3.10.0.180973.exe
MSI installer: IBMAsperaConnect-ML-FIPS-3.10.0.180973.msi

You can configure the Connect guided installation to link to the FIPS version of Connect automatically. To
do so, modify your application code to add a configuration value:

Before: var asperaInstaller = newAW4.ConnectInstaller({});
After:  var asperaInstaller = newAW4.ConnectInstaller({useFips: true});
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Troubleshooting

Error When Installing with a Non-Admin Account

About this task
You may encounter an error such as the following (or with similar wording) if you are not an Administrator
when executing the MSI installer file.

The system administrator has set policies to prevent this installation.

These error messages are due to not having permissions to install an MSI package as a non-admin
account. Other than logging in as an administrator to install Connect, you may also ask that your
Administrator grant the group policy access for non-admin users to install applications.

The following example shows you how to grant group policy access for non-admins to install software on
Windows 2016:

Procedure
1. Launch the Microsoft Management Console (MMC).

Go to Start menu > Run. Enter mmc and click OK to launch it.

2. Add the Group Policy Object Editor Snap-in.

a. In the MMC, go to the toolbar and select File > Add/Remove Snap-in:

b. In the Add or Remove Snap-ins window, select the Group Policy Object Editor and click Add:
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c. In the Select Group Policy Object window (wizard), under Group Policy Object, click Browse and
select either This Computer or specify another computer. When done, click OK to return to the
wizard window.

d. In the wizard window, click Finish. When you are returned to the Add/Remove Snap-ins window,
click OK to save the changes.

3. Grant the Windows installation group policy.

a. In the MMC, navigate into Console Root > Local Computer Policy > Computer Configuration >
Administrative Templates > Windows Components and locate Windows Installer:
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b. Double-click Windows Installer.
c. In the list that appears, locate Turn off Windows Installer and double-click it.
d. The Turn Off Windows Installer window opens.
e. Under the Turn off Windows Installer heading, select Enabled. In the Disable Windows Installer

box, open the pull-down and select Never. When finished, click OK:

f. To close the MMC, click File > Exit.
g. When prompted to save console settings, click Yes to save the settings to a file. When prompted for

a .msc filename, click Save.
h. Reboot the computer to apply the changes, or execute the following command at a command

prompt:

> gpupdate /force

Connectivity Issues

SSH Connectivity Errors: "Timeout establishing connection"
If you receive the error "Timeout establishing connection," the TCP connection between Connect and the
server is blocked (error codes 13, 15, or 40 in the log files). To determine the cause, open a Terminal or a
Command prompt on the client machine (where Connect is installed). Use telnet to test the connection
to the server:

# telnet server-ip-address 33001

where server-ip-address is the IP address of the Aspera server (ex. 10.0.1.1) on TCP port 33001 (or the
configured TCP port, if other than 33001).

You will receive one of the following errors and can take the appropriate action:
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• "Connection refused": The Aspera server is not running the SSHD service. Have your server
administrator review the server's SSH service status.

• "Timeout": The client-side firewall is disallowing outbound TCP traffic. Ensure that the client-side
firewall allows outbound TCP traffic on port 33001 (or the configured TCP port).

UDP Connectivity Errors: "Data transfer timeout"
If Connect appears to successfully connect to the server but:

• The transfer progress reads 0%.
• Files appear to be transferred to the destination but are 0 bytes.
• You eventually receive the error "Data transfer timeout."

UDP connectivity is blocked, likely by the firewall configuration (error codes 14, 15, and 18 in the log
files). Ensure that the client-side firewall allows outbound traffic on the FASP UDP port (33001, by
default) and the server firewall allows inbound traffic on UDP port 33001.

IBM Aspera Connect Diagnostic Tool
Aspera provides a web-based diagnostic tool that can be useful for identifying connection issues. You can
access the tool here:

https://test-connect.asperasoft.com/

Transfer Issues

Connect Won't Transfer .partial Files
With the default configuration for Connect, if you try to transfer files that have a .partial extension,
you'll notice these files are skipped. This is because the .partial extension has special meaning for
Connect. For a file in transit, .partial is the default temporary extension for the partial file on the
receiving end before its transfer is complete. When the file's transfer is finished, the extension is removed.

You can transfer the skipped files by changing the name of the filename extension that Connect uses.
Choose a name that you don't expect will be used by files you transfer.

To make this change:

1. Locate the Connect aspera.conf file on the machine at the receiving end of the transfer. The
aspera.conf file is included in the Connect installation. Open it with a text editor:

C:\Users\username\AppData\Local\Programs\Aspera\Aspera Connect\etc\aspera.conf

2. Go to the line that begins with <partial_file_suffix>, and change .partial to a name your
transfer files will not be using:

<?xml version='1.0' encoding='UTF-8'?>
<CONF version="2">

<default>
    <file_system>
        <storage_rc>
            <adaptive>
                true
            </adaptive>
        </storage_rc>
        <resume_suffix>.aspera-ckpt</resume_suffix>
        <partial_file_suffix>.partial</partial_file_suffix>
        <replace_illegal_chars>_</replace_illegal_chars>
    </file_system>
</default>

</CONF>
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Note: Removing the <partial_file_suffix> entry or setting it to a null value will not necessarily
solve the problem. Doing so means the file extension used for partial files becomes whatever is set in
the aspera.conf for ascp, which by default is .partial.

3. Save your changes to the the Connect aspera.conf file. The changes will take effect with the next
trtansfer.
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